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1.  Introduction 
With this tutorial we would like to make you acquainted with various features of RFEM. Often 
you will have several options to achieve your targets. Depending on the situation and your 
preferences, different ways may be useful. We would like to invite you to play with the soft-
ware to learn more about the program's possibilities. With this example we want to encourage 
you to find out useful functions in RFEM. 

The following example represents a mixed construction built of concrete and steel elements. 
We want to calculate the model for the load cases self-weight, live load, snow, wind and imper-
fections according to linear static and nonlinear second-order analysis. 

You can enter, calculate and evaluate the example of this tutorial also with demo restrictions - 
maximum 2 surfaces and 12 members. Therefore, you may understand that the model meets 
the demands of realistic construction projects only to some extent. With the features present-
ed we just want to show you how you can define model and load objects in various ways. 

As superimposing actions according to EN 1990 involves considerable time and effort, we will 
use the generator for load combinations already integrated in RFEM 5. 

With the 30-day trial version, you can work on the model without any restriction. After that pe-
riod, the demo mode will be applied so that saving data is no longer possible. In this case, you 
should allow for enough time (approximately two to three hours) to enter the data and try the 
functions without stress. You can also interrupt your work on the model in the demo version as 
long as you do not close RFEM: When you take a break, do not shut down your computer but 
use the standby mode. 

It is easier to enter data if you use two screens, or you may print the description to avoid 
switching between the displays of PDF file and RFEM input.  

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog boxes, 
tables and menus are set in italics to clarify the explanations. Input required is written in bold 
letters. 

You can look up the description of program functions in the RFEM manual that you can down-
load on the Dlubal website at www.dlubal.com/Downloading-Manuals.aspx. 

 

 

 

http://www.dlubal.com/Downloading-Manuals.aspx
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2.  System and Loads 
 

2.1 Sketch of System 
Our example is a reinforced concrete structure to which a steel construction is attached. 

 
Figure 2.1: Structural system 

The reinforced concrete structure is a substructure consisting of a floor slab with downstand 
beam, a semicircular shell and two round columns. The structural system is built partially in the 
earth. 

The steel frame is a monopitch roof construction stiffened with a diagonal. 

As mentioned above, the model represents a rather "abstract" structure that can be designed 
also with the demo version whose functions are restricted to a maximum of two surfaces and 
twelve members. 

2.2 Materials, Thicknesses and Cross-sections  
We use concrete C30/37 and steel S 235 as materials. 

The thickness of walls and floors is 20 cm each. Both concrete columns have a diameter of 30 
cm. The beam has a width of 25 cm and height of 40 cm. 

We use HE-A 300 cross-sections for the left and right steel frames of the monopitch roof struc-
ture. Both purlins are defined with HE-B 260 cross-sections. The bracing diagonal consists of an 
angle iron L 80x8 with equal legs. 
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2.3 Load 

Load case 1: self-weight and finishes 
In the first load case, the self-weight of the model including its floor structure of 1.5 kN/m2 is 
applied. We do not need to determine the self-weight manually. RFEM calculates the weight 
automatically from the defined materials, surface thicknesses and cross-sections. 

Earth pressure is acting additionally on the semicircular wall. The load ordinate at the bottom 
of the wall is determined for a gravel backfill as follows: q = 16.0 kN/m3 * 4.0 m = 64 kN/m2. 

The roof load (roofing, supporting structure) is assumed with 1.2 kN/m2. 

Load case 2: live load 
The area of the floor surface is used as an assembly room of category A1 bearing an imposed 
load of 3.0 kN/m2. 

In addition, a vertically acting linear load of 5.0 kN/m is taken into account around the open-
ing, representing a loading due to a stair access. 

Load case 3: snow 
The snow load is applied according to EN 1993-1-3 for the snow load zone 2 in Germany and 
for an altitude of 500 m. 

Load case 4: wind 
In our example we analyze wind loading only in direction Y (wind direction: from low to high 
eaves). It is applied according to EN 1991-1-4 for monopitch roofs and enclosed vertical walls. 
Furthermore, we apply wind zone 1 and terrain category III for the building. As the roof inclina-
tion is higher than 5°, we need to take into account positive and negative external pressure 
coefficients. In this load case we will assume the positive coefficients. 

The reinforced concrete area is exposed to wind loads only partially. For the column at the low 
eaves side we assume a trapezoidal equivalent load with ordinates 0.5 kN/m and 2.0 kN/m. For 
the column at the high eaves side we apply a uniform equivalent load of 1.5 kN/m. 

Load case 5: imperfection 
Often imperfections must be considered, for example according to Eurocode 3. Inclinations 
and precambers are managed in a separate load case. So it is possible to assign specific partial 
safety factors when you combine this type of load with other actions. 

In our example we will analyze imperfections only in direction Y. 

For the column cross-sections (HE-A 300) we assume the buckling curve b (displacement in  
direction of y-axis) according to EN 1993-1-1, table 6.2. The inclinations ϕ0 and precambers e0,d 
are determined according to EN 1993-1-1, section 5.3.2. 

We apply imperfections for both reinforced concrete columns according to EN 1992-1-1, 
clause 5.2. 



3  Creating Model 

 

 
Dlubal 

8 RFEM Tutorial © 2013 Dlubal Software GmbH 

 

3.  Creating Model 
 

3.1 Starting RFEM 
To start RFEM in the taskbar, we 

click Start, point to All Programs and Dlubal, and then we select Dlubal RFEM 5.01 

or we double-click the icon Dlubal RFEM 5.01 on the computer desktop. 

3.2 Creating Model File 
The RFEM work window opens showing us the dialog box below. We are asked to enter the 
basic data for the new model. 

If RFEM already displays a model, we close it by clicking Close on the File menu. Then, we 
open the General Data dialog box by clicking New on the File menu. 

 
Figure 3.1: Dialog box New Model - General Data 

We write Tutorial into the input field Model Name. To the right, we enter Construction con-
sisting of concrete and steel as Description. We always have to define a Model Name because 
it determines the name of the RFEM file. The Description field does not necessarily need to be 
filled in. 

In the input field Project Name, we select Examples from the list if not already set by default. 
The project Description and the corresponding Folder are displayed automatically. 

In the dialog section Type of Model, the 3D option is preset. This setting enables a spatial mod-
eling. We also keep the default setting Downward for The Positive Orientation of Global Axis Z. 
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The dialog section Classification of Load Cases and Combinations requires some settings: we se-
lect the entry EN 1990 from the list According to Standard. We don't change the setting CEN in 
the field National annex to the right. These specifications are important when we combine ac-
tions with partial safety factors and combination coefficients conforming to standards. 

Then, we select the check box Create combinations automatically. We want to superimpose the 
actions in Load combinations. 

Now, the general data for the model is defined. We close the dialog box by clicking the [OK] 
button. 

The empty work window of RFEM is displayed. 

4.  Model Data 
 

4.1 Adjusting Work Window and Grid 

View 
First, we click the [Maximize] button on the title bar to enlarge the work window. We see the 
axes of coordinates with the global directions X, Y and Z displayed in the workspace. 

To change the position of the axes of coordinates, we click the button [Move, Zoom, Rotate] in 
the toolbar above. The pointer turns into a hand. Now, we can position the workspace accord-
ing to our preferences by moving the pointer and holding the left mouse button down.  

Furthermore, we can use the hand to zoom or rotate the view: 

• Zoom: We move the pointer and hold the [Shift] key down. 

• Rotation: We move the pointer and hold the [Ctrl] key down. 

To exit the function, different ways are possible: 

• We click the button once again. 

• We press the [Esc] key on the keyboard. 

• We right-click into the workspace. 

Mouse functions 
The mouse functions follow the general standards for Windows applications. To select an ob-
ject for further editing, we click it once with the left mouse button.  We double-click the object 
when we want to open its dialog box for editing. 

When we click an object with the right mouse button, its shortcut menu appears showing us 
object-related commands and functions. 

To change the size of the displayed model, we use the wheel button of the mouse. By holding 
down the wheel button we can shift the model directly. When we press the [Ctrl] key addition-
ally, we can rotate the structure. Rotating the structure is also possible by using the wheel but-
ton and holding down the right mouse button at the same time. The pointer symbols shown 
on the left show the selected function. 
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Grid 
The grid forms the background of the workspace. In the dialog box Work Plane and Grid/Snap, 
we can adjust the spacing of grid points. To open the dialog box, we use the button [Settings 
of Work Plane]. 

 
Figure 4.1: Dialog box Work Plane and Grid/Snap 

Later, for entering data in grid points, it is important that the control fields SNAP and GRID  
in the status bar are set active. In this way, the grid becomes visible and the points will be 
snapped on the grid when clicking. 

Work plane 
The XY plane is set as work plane by default. With this setting all graphically entered objects 
will be generated in the horizontal plane. The plane has no significance for the data input in 
dialog boxes or tables. 

The default settings are appropriate for our example. We close the dialog box with the [OK] 
button and start with the model input. 
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List button for plane surfaces 

 

4.2 Creating Surfaces 
It would be possible to define corner nodes in the graphic or table first to connect them with 
lines which we can use to create surfaces. But in our example we use the direct graphical input 
of lines and surfaces. 

4.2.1 Floor 
The floor surface consists of a rectangular and a semicircular surface. 

4.2.1.1 Defining Rectangular Surface 

Rectangular slabs are frequently used structural components. To create rectangular plates 
quickly, 

we click Model Data on the Insert menu, then we point to Surfaces, Plane and  
Graphically and select Rectangle, 

or we use the corresponding list button for the selection of plane surfaces. We click the arrow 
button [] to open a pull-down menu offering a large selection of surface geometries. 

With the menu item [Rectangle] we can define the plate directly. Related nodes and lines will 
be created automatically. 

After selecting this function, the dialog box New Rectangular Surface opens. 

 
Figure 4.2: Dialog box New Rectangular Surface 

The Surface No. of the new rectangular plate is specified with 1. It is not necessary to change 
this number. 

The Material is preset with Concrete C30/37 according to EN 1992-1-1. When we want to use a 
different material, we can select another one by means of the [Material Library] button. 

The Thickness of the surface is Constant. We increase the value d to 200 mm, either by using 
the spin box or by direct input. 

In the dialog section Surface Type the Stiffness is preset appropriately with Standard. 

We close the dialog box with the [OK] button and start the graphical input of the slab. 
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We can make the surface definition easier when we set the view in Z-direction (top view) by 
using the button shown on the left. The input mode will not be affected. 

To define the first corner, we click with the left mouse button into the coordinate origin (co-
ordinates X/Y/Z 0.000/0.000/0.000). The current pointer coordinates are displayed next to the 
reticle. 

Then, we define the opposite corner of the slab by clicking the grid point with the X/Y/Z coor-
dinates 7.000/6.000/0.000. 

 
Figure 4.3: Rectangular surface 1 

RFEM creates four nodes, four lines and one surface. 

As we don't want to create any more plates, we quit the input mode by pressing the [Esc] key. 
We can also use the right mouse button to right-click in an empty area of the work window. 

Show numbering 
If we want to display the numbering of nodes, lines and surfaces, we right-click into an empty 
space of the work window. A shortcut menu with useful functions appears. We activate the 
Numbering. 

 
Figure 4.4: Show numbering in shortcut menu 
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We can use the Display tab in the navigator to control the numbering of objects in detail. 

 
Figure 4.5: Display navigator for numbering 
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4.2.1.2 Creating Arc 

Now, we need to define an area that is limited by a circular arc. 

We click the arrow [] of the list button for lines available in the toolbar to open the pull-down 
menu offering tools for special line types. We select the entry Arc via Three Nodes. 

 
Figure 4.6: List button for lines - Arc via Three Nodes 

In the work window, we click the following nodes one after the other: node 4, the grid point 
with the coordinates 10.000/3.000/0.000 and node 3. After clicking the last node, the arc will 
be created as line 5. 

 
Figure 4.7: Defining a circular arc with three points 

To quit the input mode, use the [Esc] button. 
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4.2.1.3 Adjusting Floor Surface 

As the demo version allows for the definition of only two surfaces, we cannot define the semi-
circular surface as a new surface. Therefore, we extend the rectangular surface to a general 
plane surface enclosing the arc area. 

We double-click surface 1 in the work window to open the dialog box Edit Surface. 

 
Figure 4.8: Modifying boundary lines 

We have two input options: 

• In the input field Boundary Lines No., we can enter the numbers of the new border lines  
1, 2, 4 and 5 manually. 

• We can use the [Select] button shown on the left to select the new boundary lines graph-
ically in the work window. But first it is necessary to empty the preset list in the selection 
window Edit Surface by clicking the button [Clear]. 

Now, the floor surface looks like the figure below. 

 
Figure 4.9: Floor slab 
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4.2.2 Wall 
Copy the arc 
The most comfortable way to create a curved surface is copying the circular arc by specifying 
particular settings for the copy process. 

We click arc line 5 with the left mouse button (single click) to select it. The line is now displayed 
with a different color. Yellow is preset as selection color for black backgrounds. 

We use the toolbar button shown on the left to open the dialog box Move or Copy. 

 
Figure 4.10: Dialog box Move or Copy 

We increase the Number of copies to 1: With this setting the arc won't be moved but copied.  
As the wall is 4 m high (system line), we enter the value 4.0 m for the Displacement Vector in dz. 

Now, we click the [Details] button to specify more settings. 
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Figure 4.11: Dialog box Detail Settings for Move/Rotate/Mirror 

In the dialog section Connecting, we select the check box of the following option: 

  Create new surfaces between the selected lines and their copies 

Then, we select surface 1 from the list to define it as Template surface. In this way, the proper-
ties of the floor slab (material, thickness) are preset for the new wall surface. 

We close both dialog boxes by clicking the [OK] button. 
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Set the isometric view 

We use the toolbar button shown on the left to set the [Isometric View] because we want to 
display the model in a graphical 3D representation. 

 
Figure 4.12: Model in isometric view with navigator and table entries 

Checking data in navigator and tables 
All entered objects can be found in the directory tree of the Data navigator and in the tabs of 
the table. The entries in the navigator can be opened by clicking the [+] sign (like in Windows 
Explorer). To switch between the tables, we click the individual table tabs. 

In the navigator entry Surfaces and in table 1.4 Surfaces, we see the input data of both surfaces 
in numerical form (see figure above). RFEM created the wall as a quadrangle surface, i.e. a shell 
that is limited by four lines. 
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List button for openings 

4.2.3 Opening 

4.2.3.1 Creating Opening 
Now, we insert a rectangular opening into the floor slab. The data input is easier when we  
reset the [View in Z direction]. 

We can apply the opening directly, which means without defining lines first. We use the list 
button for openings available in the toolbar and select the entry Rectangle. 

We set the first opening node in grid point 3.000/1.000/0.000. The second node is defined in 
grid point 5.000/2.000/0.000. 

The opening is too small. We will adjust its length in the next step. 

 
Figure 4.13: Defining the rectangular opening 

We close the input mode with the [Esc] button or with a right-click into the empty workspace. 
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4.2.3.2 Adjusting Opening 
The length of the opening is 2.50 m. We select nodes 11 and 12 one after the other by holding 
down the [Ctrl] key when clicking. 

We open the dialog box Edit Node with a double click on one of these nodes. 

 
Figure 4.14: Dialog box Edit Node 

Both nodes are listed in the input field Node No. We correct the Coordinate X by entering  
5.500 m, and then we confirm the input with [OK]. Now, the opening has an appropriate 
length. 

Alternative: It is also possible to apply the opening instantly without modifying coordinates 
when we use an adjusted grid: Before, we have to open the dialog box Work Plane and 
Grid/Snap (see Figure 4.1, page 10) where we reduce the Grid Point Spacing to 50 cm. We can 
also use the shortcut menu of the GRID button available in the status bar to modify the grid 
spacing quickly. Just right-click the button shown on the left. 

Now, the input of surfaces is complete. 
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4.3 Creating Concrete Members 

4.3.1 Columns 
Member elements depend on lines: By creating a member a line is generated automatically. 

Changing the work plane 
We want to define the columns graphically, so we need to shift the work plane from the hori-
zontal to the vertical plane. To set the [Work Plane YZ], we click the second of the three plane 
buttons in the toolbar. 

We reset the [Isometric View]. Now, we can see that the input grid is spanned in the plane of 
the two columns (see Figure 4.18). 

Definition of cross-section 
We click the list button [New Members Single] to open the dialog box New Member. 

 
Figure 4.15: Dialog box New Member 

It is not necessary to change the default settings. We only have to create a Cross-Section. To de-
fine the cross-section at the Member start, we click the [Library] button. The cross-section data-
base appears. 
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Figure 4.16: Cross-Section Library 

In the dialog section Parametric - Massive, we select the cross-section type Circle. Another  
dialog box appears. 

 
Figure 4.17: Dialog box Solid Cross-Sections - Circle 

We define the column diameter D with 300 mm. 

For solid cross-sections RFEM presets number 1 - Concrete C30/37 as Material. 

We can use the [Info] button to check the properties of the cross-section. 
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We click [OK] to import the cross-section values and return to the initial New Member dialog 
box. Now the input field Member start shows the new cross-section. We close the dialog box 
with [OK] to set the columns graphically. 

Graphical definition of members 
We define the footing of the front column by clicking the grid point 0.000/6.000/4.000. 

The top end of the column is set into node 2. 

 
Figure 4.18: Defining the footing of the second column 

The input command Define member is still active. Therefore, we can continue with the defini-
tion of the rear column. 

We place the footing of the second column into the grid point 0.000/0.000/4.000. The 
column's top end is then defined in the grid zero point which is node 1. 

To quit the input mode, we use the [Esc] key. We can also right-click into the empty work  
window. 
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4.3.2 Rib 
In the next step, we enter the downstand beam below the ceiling. 

Modification of line properties 
We double-click line 3 to open the dialog box Edit Line. We change to the second tab Member 
where we select the check box of the option Available (see Figure 4.19). 

The dialog box New Member opens again. 

 
Figure 4.19: Dialog box New Member 

This time we click the [New] button to define a cross-section at the Member start. 

In the upper part of the dialog box New Cross-Section, we select the massive REC cross-section 
table. The dialog box Solid Cross-Sections - Rectangle opens where we define the width b with 
250 mm and the depth h with 400 mm. 
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Figure 4.20: Dialog box Solid Cross-Sections - Rectangle 

We click [OK] to import the cross-section values to the dialog box New Cross-Section. Again, 
material number 1 - Concrete 30/37 is preset. 

We click [OK] and return to the initial dialog box New Member. Now the input field Member 
start shows the rectangular cross-section. 
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Definition of rib 
In RFEM we can model a downstand beam with the member type Rib. We just change the 
Member Type in the dialog box New Member: We select the entry Rib from the list. 

 
Figure 4.21: Changing the member type 

With a click on the button [Edit Member Type] we open the dialog box New Rib. 

 
Figure 4.22: Defining the rib 
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We define the Position and Alignment of the Rib On +z-side of surface. This is the bottom side 
of the floor slab. 

For the Effective Width we specify L/8 for both sides. RFEM will find the surfaces automatically. 

We close all dialog boxes with the [OK] button and check the result in the work window. 

Display options 
RFEM displays the rib as a member that is eccentrically arranged. As the transparent rendering 
model does not show surface thicknesses, we set the Solid Display Model by means of the list 
button shown on the left. This display mode helps us to check the placement of the rib. 

In addition, we set the rendering option Filled incl. thickness available in the Display navigator. 

 
Figure 4.23: Graphical representation of solid model 

To adjust the display, we use the button [Move, Zoom, Rotate] (see "mouse functions" on page 
9). The pointer turns into a hand. When we hold down the [Ctrl] key additionally, we can rotate 
the model by moving the pointer. 

For the following input we reset the mode of the Solid Transparent Display Model. We also reset 
the rendering for surfaces to Filled provided in the Display navigator in order to hide thicknesses. 
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4.4 Defining Supports 
The model is still without supports. In RFEM we can assign supports to nodes, lines, members 
and surfaces. 

4.4.1 Nodal Supports 
The columns are supported on their footing in all directions but without restraint. 

We select the bottom nodes of the columns by drawing a window across the area including 
the nodes X and Y. Then, we click the toolbar button [New Nodal Support] to open the dialog 
box New Nodal Support. 

 
Figure 4.24: Selecting column nodes with window 

Both node numbers 13 and 14 are shown in the field Node No. 

We modify the type of the support because the preset support type 1 results in a restraint 
about the longitudinal member axis. With a click on the button [New] (see Figure 4.25) we 
open another dialog box. 
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Figure 4.25: Defining degrees of freedom 

In the second dialog box New Nodal Support, we remove the check mark of the Restraint for  
rotation φZ’. 

We confirm the dialog boxes with [OK]. Now, we see support symbols displayed on the model. 
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4.4.2 Line Supports 
The bottom line of the curved wall is supported as well. This time, we choose another way to 
enter support data. First, we define the support properties. Then, we assign them to the object 
graphically. 

With a click on the button [New Line Support] we open the dialog box New Line Support. 

The option Hinged is preset as Type of Support. The first three selected check boxes are indicat-
ing that a support is available in the directions X, Y and Z. The final three boxes are not select-
ed because the hinged support type has no restraint about X, Y and Z. 

We confirm the dialog box with [OK] because the hinged support is adequate for our example. 

 
Figure 4.26: Dialog box New Line Support 

RFEM displays a support symbol next to the mouse pointer. It becomes a reticle as soon as we 
approach a line. The number of the corresponding line is displayed in the status bar. We set 
the support on the curved line 6. 

Now, the input of the model's reinforced concrete construction is complete. 

 
Figure 4.27: Reinforced concrete structure with supports 
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4.5 Creating Steel Members 

4.5.1 Frame 
Now we enter the steel construction. First, we define the frame that lies in the plane of the two 
columns. It is helpful to use a so-called visibility for this plane: This type of partial view allows 
us to work in a particular zone of the model and we are not disturbed by objects that lie within 
another plane. 

Creation of visibilities 
We set the Views tab in the navigator. A number of visibilities is already available. They were 
Generated by RFEM based on the data we entered. 

The button [Visibility by Window] makes it possible to abstract a specific zone from the model 
graphically: We activate the function and draw a window from the left to the right, completely 
enclosing both column members. 

Please note: If you pull up the window from the left to the right, the visibility contains only ob-
jects that are completely within this window. If you pull up the window from the right to the 
left, the visibility additionally contains those objects that are cut by the window. 

Now we can see that the rest of the model (floor, wall) is displayed with a lower color intensity. 
The corresponding objects cannot be edited. 

 
Figure 4.28: Creating a visibility by window 

Changing the origin of the work plane 
Plane YZ is still set as the work plane, which is appropriate for defining the frame of the mono-
pitch roof. Also the origin of the work plane is convenient for our purpose. However, we want 
to show you how you can adjust the work plane. Therefore, we modify the position of the work 
plane origin. 

We click the toolbar button [Set Origin]. Then, in the work window, we select node 2, which is 
the head of the front column, to be the new origin of the work plane. The reticle of the grid 
changes its position. 
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Figure 4.29: New origin in node 2 

4.5.1.1 Defining Members Continuously 
We want to create the monopitch roof frame as a polygonal chain. We open the list button 
[New Member] and select the menu item Member Continuous. 

The dialog box New Member opens. First, we change the Member Type to Beam. 

As shown in Figure 4.19 on page 24, we create a cross-section for the Member start by using 
the [New] button. The dialog box New Cross-Section opens where we click the button [HE-A]  
at its top. Then, in the dialog box Rolled Cross-Sections - I-sections, we select the cross-section 
HE A 300 from the HE A cross-section table. For rolled cross-sections RFEM presets number  
2 - Steel S 235 as Material. 

 
Figure 4.30: Selecting HE A 300 in the library 
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We confirm all dialog boxes with [OK]. 

Back in the work window, we define the three frame members in one go by clicking the follow-
ing nodes and grid points: 

• Node 1 

• Grid point 0.000/-6.000/-3.000 (grid origin has been modified) 

• Grid point 0.000/0.000/-3.000 (roof inclination will be adjusted later) 

• Node 2 

 
Figure 4.31: Defining members continuously 

When the last node is defined, we right-click twice into the empty work window to quit the  
input mode. 

Both columns in our model are connected rigidly to the floor nodes 1 and 2. Though this kind 
of restraint can hardly be built in reality, we do without a modeling of release properties in our 
example and accept this simplification. 
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4.5.1.2 Shearing Horizontal Beams 
The monopitch roof has an inclination of 8°. That's why we have to adjust the horizontal beam. 

We draw a selection window across member 5 comprising both end nodes. Then, in the toolbar 

we select Shear on the Edit menu 

to open the dialog box 3D Shearing. 

 
Figure 4.32: Adjusting the inclination of the horizontal beam 

We want to modify the inclination of the beam by -8° About axis X. We have to enter a nega-
tive value because the objects will be rotated counterclockwise about the axis X. The shearing 
is applied in vertical direction Z. Finally, we define the 1st point of the rotation axis by using the 
[Select] button. We select node 15 having the coordinates 0.000/0.000/-3.000 and confirm 
the input with [OK]. 
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4.5.1.3 Connecting Beams with Releases 

Release definition 
The horizontal beam cannot transfer any bending moments into the columns because of its 
connection type. Therefore, we define a release that we assign to both sides of the beam later. 

This time we use the Data navigator: We right-click the entry Member End Releases and select 
New Member End Release in the shortcut menu. 

 
Figure 4.33: Opening the dialog box New Member End Release in the Data navigator 

In the dialog box New Member End Release, displacements or rotations can be selected that are 
released at the member end. In our example, those are the rotations φy and φz. Thus, no bend-
ing moments can be transferred at the node. 

We close the dialog box by clicking the [OK] button without modifying any data. 

Release assignment 

It would be possible to double click the member to open the dialog box Edit Member and as-
sign the releases. However, we use a special function that is available in the following menu: 

On the Insert menu, we select Model Data, point to Member Releases and select  
Assign to Members Graphically. 

The dialog box Assign Member End Releases to Members Graphically appears. We open the list 
and select release type 1 that we have just defined. Then, we click [OK]. 

 
Figure 4.34: Dialog box Assign Member End Releases to Members Graphically 

We see in the work window that RFEM has applied a one-third division to the members. By 
clicking the end of a member we can define the release graphically at this member end.  
Now we click member 5 in its middle area to assign the release to both sides. 
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Figure 4.35: Assigning release graphically 

4.5.1.4 Reverse Member Orientation 
For the graphical representation of imperfections it may be comfortable for us when the mem-
ber orientation of columns is directed from the bottom to the top. Therefore, we change the 
orientation of the right steel column, using a function of the member shortcut menu. 

Moving the pointer near member 6, we can see the orientation arrow appearing on the mem-
ber. We right-click the member and open its shortcut menu where we select the menu item  
Reverse Member Orientation. 

 
Figure 4.36: Shortcut menu of member 
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4.5.1.5 Copying Frame 
The second frame of the monopitch roof can be created very quickly as a copy. 

We draw a selection window across the frame, enclosing members 4 to 6. Please take care not 
to include any of the concrete columns! If necessary, you can rotate the model to set a more 
favorable view. We can also click the members one after the other by holding down the [Ctrl] 
key. 

Before we create the copy, we set the [Work Plane XZ] so that we are able to copy the structure 
out of the frame plane. 

We press the [Ctrl] key. Now, we grab the selection near the foot point of the higher column 
(node 2) and shift it to the arc end at the wall top. The [+] symbol next to the mouse pointer 
indicates that the objects are being copied. As soon as the coordinates of the grid point 
7.000/6.000/0.000 are displayed in the status bar, we release the mouse button. 

 
Figure 4.37: Copying frame by drag-and-drop 

Nodes and lines are merged automatically with already defined objects. 
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4.5.2 Purlins 

4.5.2.1 Defining Members Individually 
Again, we use the list button [New Member] for the definition of both purlins. We select the 
option Member Single and open the dialog box New Member. 

We define a cross-section for the Member start by using the [New] button again (see Figure 4.19, 
page 24). 

In the dialog box New Cross-Section, we click the button [HE-B] at the box top. The dialog box 
Rolled Cross-Sections - I-Sections opens where we select the cross-section HE B 260 from the  
HE B cross-section row (see figure below). Again, number 2 - Steel S 235 is preset. 

 
Figure 4.38: Selecting HE B 260 in the library 

We confirm all dialog boxes with [OK]. 

We define the purlin at the lower eaves by clicking nodes 15 and 19 one after the other. 

Then we click nodes 16 and 20 to create the second purlin. 
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Figure 4.39: Defining purlin members 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 
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4.5.2.2 Connecting Members Eccentrically 
We want to connect the purlins eccentrically to the frame columns. Thus, we shorten the  
system line by half of the cross-section height of the HE A 300 columns. 

Definition of eccentricity 

We double-click the purlin at the high eaves (member 11). In the dialog box Edit Member, we 
change to the dialog tab Options. In the dialog section Member Eccentricity, we click the [New] 
button to open the dialog box New Member Eccentricity. 

 
Figure 4.40: Dialog box New Member, tab Options and dialog box New Member Eccentricity 

We select the option Transverse offset from cross-section of other object. In our example, the  
Object is the column: We use the [Select] function to select Member 6 graphically. 

Then, we define the Axis offset in direction of the positive cross-section axis z. 

Finally, in the dialog section Axial offset from adjoining members, we select the check boxes for 
Member start and Member end to arrange the offset on both sides. 

After confirming all dialog boxes we can check the result with a maximized view (for example 
zooming by rolling the wheel button, moving by holding down the wheel button, rotating by 
holding down the wheel button and keeping the right mouse button pressed). 
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Figure 4.41: Eccentric connection of purlin in zoomed view 

Apply eccentricity to another member 
To transfer the eccentricity to the second purlin, we use the input tables. 

We set table 1.17 Members listing numerically the member data of all members that we have 
defined so far. When we click into table row 10, we see that the second purlin is highlighted in 
the work window and displayed in the selection color. 

 
Figure 4.42: Assigning eccentricity in table 1.17 Members 

We place the pointer into column I and enter 1, which is the number of the eccentricity that we 
have just defined. We can also select it from the list. 

After leaving the table cell with the [Tab] or [↵] key, we see the modification displayed in the 
graphic. 

In the same way, it would be possible to define another eccentricity for the horizontal beams. 
However, as these members are connected to the column webs, we want to neglect those  
additional moments in our example. 
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4.5.3 Diagonal 
The final member that we insert is a diagonal for stiffening. It can only transfer tensile forces. 
Generally, bracings are defined crosswise but the calculation in the demo version only allows 
for 12 members. A tension member has the effect that the model is calculated non-linearly. In 
case of compression forces, this member is removed from the stiffness matrix (failure). 

4.5.3.1 Defining Member 
With the button [Member Single] we open again the dialog box New Member where we select 
the entry Tension from the Member Type list. 

We define a new cross-section for the Member start by using the button [New] (see Figure 4.19, 
page 24) that opens the cross-section database. 

In the dialog box New Cross-Section, we click the [L] button. The dialog box Rolled Cross-Sections 
- L-Sections appears where we select cross-section L 80x8 from the cross-section table L. The 
material 2 - Steel S 235 is preset again. 

 
Figure 4.43: Defining tension member with cross-section L 80x8 

We confirm all dialog boxes with [OK], and then we click the nodes 15 and 2 one after the other 
to define the diagonal (see figure below). 

To quit the input mode, we use the [Esc] key. We can also right-click into the empty work win-
dow. 
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Figure 4.44: Defining the diagonal 

4.5.3.2 Rotating Member 
A tension member adds to stiffness only by its cross-sectional area. Thus, seen from a structural 
point of view, the rotation of the member is not irrelevant. For the rendered view, however, we 
want to rotate the angle section. 

We double-click member 12 to open the dialog box Edit Member where we define a member 
rotation of -90°. 

 
Figure 4.45: Defining a member rotation 

Again, we can check the result in a maximized view by using the zoom and moving function 
(see page 9).      
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Figure 4.46: Rotated angle member in zoomed view 

Undo/restore 
If you want, you can [Undo] the member rotation in this view in order to check the initial posi-
tion of the cross-section. With the default functions Undo and Redo that you already know 
from Windows applications we can undo or restore input data in RFEM, too. 

 
Figure 4.47: Buttons Undo and Redo 

Cancel visibility mode 
The parts of the model displayed in RFEM as transparent objects can be reactivated in the 
Views navigator: With a click on the button [Cancel Visibility Mode] all objects are fully dis-
played again. With the toolbar button [Isometric View] we can reset the spatial full view. 

 
Figure 4.48: Full view of model 
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Adjusting the color assignment 
The Display navigator provides an option to display Colors in Rendering According to particular 
criteria. The default setting is the display of material colors. 

You can click through the menu items to see how the display changes. With the option Cross-
Sections for example we can distinguish different cross-section types at a glance. 

 
Figure 4.49: Distinguishing cross-sections by colors 

For the following input we reset the option Materials. 

4.6 Checking Input 

Checking Data navigator and tables 
As mentioned before, RFEM offers us various possibilities to enter model data. The graphical 
input is reflected in both the Data navigator tree and the tables. We can display and hide navi-
gator and tables by selecting Navigator or Table on the View menu. We can also use the cor-
responding toolbar buttons. 

In the tables, the model objects are organized in numerous tabs. Graphics and tables are inter-
active: To find an object in the table, for example a member, we set table 1.17 Members and se-
lect the member in the work window by clicking. We see that the corresponding table row is 
highlighted (see Figure 4.42, page 41). 

We can check the numerical data of our input quickly. 

Saving data 
Finally, the input of model data is complete. To save our file, 

we select Save on the File menu 

or use the toolbar button shown on the left. 
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5.  Loads 
The Data navigator contains the following entries in the folder Load Cases and Combinations: 

• Load cases 
• Actions 
• Combination expressions 
• Action combinations 
• Load combinations 
• Result combinations 

We define the actual loading like self-weight, snow and wind load in load cases. Then, load 
cases are organized in actions and superimposed with partial safety factors according to the 
standard's combination expressions (see chapter 6). 

5.1 Load Case 1: Self-weight 
The first load case contains the permanently acting loads from self-weight, floor structure, 
earth pressure and roof finishes (see chapter 2.3, page 7). 

We use the button [New Surface Load] to create a load case. 

 
Figure 5.1: Button New Surface Load 

The dialog box Edit Load Cases and Combinations appears. 

 
Figure 5.2: Dialog box Edit Load Cases and Combinations, tabs Load Cases and General 
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Load case no. 1 is preset with the action type Permanent. In addition, we enter the Load Case 
Description Self-weight, finishes, earth pressure. 

5.1.1 Self-weight 
The Self-Weight of surfaces and members in direction Z is automatically taken into account 
when the factor Active is specified with 1.000  as already preset. 

5.1.2 Floor Structure 
We confirm the input by clicking the [OK] button. The dialog box New Surface Load appears. 

 
Figure 5.3: Dialog box New Surface Load 

The floor structure is acting as load type Force, the load distribution is Uniform. We accept 
these presettings as well as the setting ZL for Global in the dialog section Load Direction. 

In the dialog section Load Magnitude, we enter a value of 1.5 kN/m2 (see chapter 2.3, page 7). 
Then, we close the dialog box by clicking [OK]. 

Now, we can assign the load graphically to the floor surface: We can see that a small load sym-
bol has appeared next to the pointer. This symbol disappears as soon as we move the pointer 
across a surface. We apply the load to the floor with a click on surface 1 (see Figure 5.4). 

The surface load is not applied to the opening. We can see the non-load bearing area identified 
by the load application symbol. 

We can hide and display the load values with the toolbar button [Show Load Values]. 

To quit the input mode, we use the [Esc] key. We can also right-click into the empty work win-
dow. 
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Figure 5.4: Graphical input of floor load 

5.1.3 Earth Pressure 
The earth pressure stressing the wall is represented by a linearly variable load acting perpen-
dicular to the surface. This time, we select the curved surface 2 first, and then we open the cor-
responding dialog box for load input by using the button [New Surface Load]. 

 
Figure 5.5: Dialog box New Surface Load 
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Display of local axis systems 

 

The load is set as load type Force with the Load Distribution Linear In Z. Thus, we select Local z 
as Load Direction. 

To enter the Load Magnitude, we use the [Select] button to select significant locations on the 
model to which we assign load ordinates: We click Node No. 3 and enter the Magnitude 0 kN/m2. 
Then, we click the [Select] button again to select Node No. 6 to which we assign the Magnitude  
-64 kN/m2 (see chapter 2.3, page 7). We enter the load with a negative number because the  
local z-axis of the surface is directed to the outside. 

After confirming the dialog data by clicking [OK], we see the linear surface load displayed in the 
model, increasing downwards and acting perpendicularly on the shell. We use the shortcut menu 
shown on the left (appears when we right-click the surface) to show the local surface axes. 

 
Figure 5.6: Linearly variable surface load (soil pressure) with display of local surface axes 

5.1.4 Roof Load 
The loading due to roof finishes (roofing, supporting structure) is acting as permanent load, 
too. For applying loads acting upon surfaces to the steel construction, RFEM offers us a tool 
that is able to convert area loads into member loads. 

To open the generator dialog box, 

we point to Generate Loads on the Tools menu, and then we select From Area Loads 
via Plane. 

In the dialog box Convert Area Loads to Member Loads via Planes, we specify the following set-
tings (see Figure 5.7): 

The Area Load Direction of the roof structure is Global related to the true area ZL with the Area 
Load Magnitude 1.2 kN/m2 (see chapter 2.3, page 7). 

Then, we define the plane of the area load graphically by means of the [Select] button: In the 
work window, we click the four corner nodes of the roof area 16, 15, 19 and 20 one after the 
other. Finally, we close the selection window with [OK]. 

The roof's supporting structure introduces the roof loading (not displayed in the model) into 
the structural system along the purlins. This means: Both horizontal beams of the monopitch 
roof do not participate in transferring loads from the roof loading. Thus, they must be exclud-
ed from the load generation. We use the [Select] button shown on the left, available in the dia-
log section Remove Influence from, to select one of the horizontal beams graphically in the 
work window (member 8 or 5). We click [OK] in the selection window. After that, the generator 
dialog box should look as follows. 
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Figure 5.7: Dialog box Convert Area Loads to Member Loads via Planes 

We confirm the dialog settings with [OK]. An Info dialog box appears showing us information 
about the conversion of area load values into member loads. We confirm this dialog data as 
well. 

The loading is represented as roof area load. To display the generated loads acting on both 
purlins, we right-click this load and open the shortcut menu where we select the option  
Disconnect Generated Load. 

 
Figure 5.8: Member loads from area loads on purlins 

However, we [Undo] this specification step: The input parameters entered in the generator dia-
log box get lost for disconnected loads. It would no longer be possible to adjust for example 
the load magnitude in case of subsequent modifications. 

Now, the input for the load case Self-weight is complete. 
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5.2 Load Case 2: Live Load 
Before we enter live loads, we create a new load case. To open the corresponding dialog box, 

we point to Load Cases and Combinations on the Insert menu and select Load Case, 

or we use the corresponding button in the toolbar (to the left of the load case list). 

 
Figure 5.9: Dialog box Edit Load Cases and Combinations, tab Load Cases 

For the Load Case Description we enter Imposed load, or we choose the entry from the list. 

We change the Action Type to Qi C Imposed - category C: congregation areas (see chapter 
2.3, page 7) by using the selection list. This classification is important for the partial safety  
factors and combination coefficients of the load combinations. 
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5.2.1 Floor Slab 
We choose a new input option to enter the surface load: First, we select floor surface 1 with  
a mouse click. Now, when we open the already familiar dialog box by means of the button  
[New Surface Load], we can see that the number of the surface is already entered. 

 
Figure 5.10: Dialog box New Surface Load 

The imposed load is acting as load type Force, the load distribution is Uniform. We accept these 
presettings as well as the setting ZL for Global in the dialog section Load Direction. 

In the dialog section Load Magnitude, we enter a value of 3 kN/m2 (see chapter 2.3, page 7). 
Then, we close the dialog box by clicking [OK]. 
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5.2.2 Edge of Opening 
It is easier to apply the linear load to the edge of the opening when we maximize the display of 
this area by using the Zoom function or the wheel button. 

With the toolbar button [New Line Load] to the left of the button [New Surface Load] we open 
the dialog box New Line Load. 

 
Figure 5.11: Dialog box New Line Load 

The line load as load type Force with a Uniform load distribution is acting in the load direction 
ZL. 

In the dialog section Load Parameters, we enter 5 kN/m. After clicking the [Ok] button we click 
line 11 at the opening's edge (check by display in status bar). 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 
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5.3 Load Case 3: Snow 
Again, we create a [New Load Case] to enter the snow load. 

 
Figure 5.12: Dialog box Edit Load Cases and Combinations, tab Load Cases 

For the Load Case Description we enter Snow, or we choose the entry from the list. 

We set the Action Type to Qs Snow (H ≤ 1000 m a.s.l.). 

5.3.1 Roof 
To enter the snow load for the monopitch roof, we use a load generator again. To open the 
corresponding dialog box, 

we point to Generate Loads on the Tools menu, then we select From Snow Loads and 
Flat/Monopitch Roof. 

The dialog box Generate Snow Loads - Flat/Monopitch Roof opens where we define the follow-
ing input (see Figure 5.13). 

We select the Snow Load Parameters according to the national annex for Germany for snow 
load Zone number 2. Furthermore, we change the value of the Altitude to 500 m (see chapter 
2.3, page 7). 

Then, we define the Roof Geometry graphically by using the [Select] button: We click the four 
corner nodes of the roof area 16, 15, 19 and 20 one after the other (see selection window 
shown on the left). 

We check if the new LC3 is set in the dialog section Load Case to Generate. 

Again, we want to create Member loads, but both monopitch roof beams do not make a con-
tribution to the load transfer (the snow loads are introduced into the structural system by the 
roof's supporting structure via purlins). We use the [Select] button shown on the left, available 
in the dialog section Remove Influence from, to select one of the horizontal beams graphically 
(member 8 or 5). 
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List button for loads 

   

 
Figure 5.13: Dialog box Generate Snow Loads - Flat/Monopitch Roof 

We confirm the dialog settings with [OK]. An Info dialog box appears showing us information 
about the conversion of area load values into member loads. We confirm this dialog data as 
well. The load is represented as roof area load with a value of 1.282 kN/m2. 

To display the generated loads acting on both purlins, we can use the option Disconnect Gen-
erated Load which is available in the load shortcut menu. In this way, we can make visible both 
member loads of 4.023 kN/m each. 

Separating loads should be undone immediately by using the [Undo] function so that the  
input is kept in the generator dialog box. 

5.3.2 Floor 
Snow loading also acts on the semicircular area of the floor surface. As surface 1 is stressed on-
ly partially by snow, we cannot use the function New Surface Load. In the full and trial versions 
of RFEM, it would be advisable to subdivide the floor into two surfaces in order to simply set a 
surface load on the semicircular surface. As the demo version allows only for two surfaces used 
in the model, we choose a more complex input option. 

First, we set the [View in Z direction]. Then, we select plane [XY] as our new work plane. 

We define the snow load as Free Polygon Load. We find the corresponding function in the list of 
the toolbar button [New Load] (to the right of the button [Surface Load]). 

The dialog box New Free Polygon Load opens (see Figure 5.14) where we define the load to be 
acting On Surfaces No. 1 and Global related to projected area ZP. In contrast to dead loads (like 
self-weight) which refer to the true area, snow loads must be related to the base area (this dif-
ference is not significant for horizontal surfaces). 

The load is projected in the XY Plane. 
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Figure 5.14: Defining new free polygon load by clicking arc points 

We define the Load Position in the work window by using the [Select] button: We start at arc 
node 4 at the top of the arc, and then we use the reticle cursor to click any points on the arc 
line one after the other so that we approach the semicircular surface with a polygonal chain. 
As soon as we reach the arc end at node 3, we close the yellow dialog box with [OK]. 

In the dialog section Corner Point Numbers and Load Magnitudes, we enter the value 1.284 kN/m2 
which was given as roof snow load by the generator. 

We click [OK]. RFEM puts the load on the semicircular surface. We close the input mode with the 
[Esc] button or a right-click into the empty workspace. Then, we change to the [Isometric View]. 
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Figure 5.15: Snow loads 

5.4 Load Case 4: Wind 
We create a [New Load Case] for the wind loads in direction Y. 

 
Figure 5.16: Dialog box Edit Load Cases and Combinations, tab Load Cases 

In the dialog field Load Case Description, we select Wind in +Y from the list. The Action Type 
changes automatically to Qw Wind. 
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5.4.1 Steel Construction Loads 
Again, we use a load generator to enter the wind load applied to the walls that are closed on 
all sides and to the monopitch roof. To access the corresponding function, 

we point to Generate Loads on the Tools menu, and then we select From Wind Loads 
and click Vertical Walls with Roof. 

In the dialog box Generate Wind Loads - Vertical Walls with Roof, we specify the following set-
tings (see Figure 5.17): 

The Velocity Pressure is defined according to the national annex of Germany for Wind zone 1 
and Terrain category III (see chapter 2.3, page 7). The [Info] buttons facilitate the assignment. 
Finally, we change the value of the Structure height to 8 m. 

Furthermore, we define the Base Geometry with the [Pick] button, selecting floor nodes 1, 4, 3 
and 2 (please pay attention to the order shown in the dialog sketch). For the roof geometry we 
use the [Pick] function again, clicking the roof nodes 15, 19, 20 and 16. 

We check if wind direction A - B is set in the dialog section Set Wind on Side. 

In the dialog section Load Case to Generate, we deactivate both load cases w- and w+'. As de-
scribed in chapter 2.3, page 7, we want to analyze only the positive external pressure coeffi-
cients. The load of LC w+ will be generated for LC4. 

Again, we want to create Member loads, but the monopitch roof beams do not make a contri-
bution to the load transfer. We use the [Pick Member] button shown on the left, available in 
the dialog section Remove Influence from, to select one of the horizontal beams graphically 
(member 8 or 5). The diagonal member 12 is automatically excluded from the load transfer. 

 
Figure 5.17: Dialog box Generate Wind Loads - Vertical Walls with Roof 
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After clicking [OK] a dialog box appears showing us information about the generation data. We 
click [OK] to confirm the dialog box. Now, we can see the wind loads displayed as surface loads 
on the model. 

In addition, we can use the option Disconnect Generated Loads available in the load shortcut 
menu to make the member loads visible. However, we undo this operation immediately. 

5.4.2 Column Loads 
The loads applied to the lower part of the structure will be defined manually. 

Defining a uniform member load 

The wind suction acts on the column at the high eaves side with a constant value. 

We select column member 1 with a mouse click and open the dialog box shown in Figure 5.18 
with the button [New Member Load]. 

The Load Direction is globally related to the true member length in YL. The wind load compo-
nent apportioned to the column is 1.5 kN/m. We enter the value as Load Parameter. 

We click [OK]. Now we see the member load represented on the column. 

 
Figure 5.18: Defining wind suction as uniform member load 
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Defining a trapezoidal member load 

Due to a backfill set in a certain zone, the low eaves side reveals an asymmetrical load applica-
tion area for wind pressure. Thus, the load distribution on the column is variable. 

We select column member 2 and use the button [New Member Load] to open the dialog box 
New Member Load again. 

Again, the Load Direction is defined globally in YL, but the Load Distribution is Trapezoidal. 
With this setting two Load Parameters become accessible: We enter 0.5 kN/m for the member 
start p1 and 3 kN/m for the member end p2. (We defined the columns from bottom to top; thus 
the member start is equal to the column base). 

As the Load acts over total length of Member, we select the corresponding check box. 

We click [OK]. Now we see the member load represented on the second column. 

 
Figure 5.19: Defining wind pressure as trapezoidal member load 

Now, the RFEM graphic showing the generated and manually defined wind loads should look 
like the figure below. 
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Figure 5.20: Wind loads 
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5.5 Load Case 5: Imperfection 
In the final load case we define imperfections for the columns that are stressed by axial force. 

This time, we use the Data navigator to create a new load case: We right-click the entry Load 
Cases to open the shortcut menu, and then we select New Load Case. 

 
Figure 5.21: Shortcut menu Load Cases 

We choose Imperfection towards +Y from the Load Case Description list. The Action Type 
changes automatically to Imp Imperfection. 

 
Figure 5.22: Dialog box Edit Load Cases and Combinations, tab Load Cases 

We close the dialog box by clicking the [OK] button. 
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List button for loads 

5.5.1 Steel Columns 
We click the toolbar button [New Polygon Load] to open its list menu where we select the en-
try New Imperfection. The following dialog box opens. 

 
Figure 5.23: Dialog box New Imperfection 

We want to apply the imperfection in Direction of the column axes y, which is the direction of 
the 'weak' member axis that is parallel aligned with the global axis Y in our example. 

To enter the Inclination ϕ0, we use the [Edit] button that opens the dialog box Calculate Value 
of Inclination. We set Standard EN 1993-1-1 and change the Structure Height to 4 m. We click 
[OK] and return to the initial dialog box. 

According to EN 1993-1-1, table 5.1, we have to apply a Precamber e0,d /L of 1/250 (see chapter 
2.3, page 7) for the buckling curve b of cross-sections HE A 300. 

Then, we change the activity criterion for the precamber to EN 1993-1-1 (5.8) and confirm the 
dialog box with [OK]. 

Finally, we click the four steel columns with the member numbers 6, 4, 9 and 7 to assign the 
imperfections. 

We quit the function with the [Esc] key or a right-click. 
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Figure 5.24: Assigning imperfections to steel columns 

5.5.2 Concrete Columns 
Once again, we open the dialog box New Imperfection to define the inclination of the concrete 
columns. 

 
Figure 5.25: Dialog box New Imperfection 
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Again, we define the Inclination ϕ0 with the [Edit] button: In the dialog box Calculate Value of 
Inclination, we set Standard EN 1992-1-1. 

As we do not have to consider precambers in accordance with Eurocode 2, we specify the  
Precamber e0,d /L with zero (1/0.00) in the initial dialog box. 

We check if settings are defined as shown in the figure above. Then, we confirm the dialog box 
and click both concrete columns with the member numbers 1 and 2 to assign the imperfections. 

5.6 Checking Load Cases 
All five load cases have been completely entered. It is recommended to [Save] the input now. 

We can check each load case quickly in the graphics: The buttons [] and [] in the toolbar  
allow us to select previous and subsequent load cases. 

 
Figure 5.26: Browsing the load cases 

The loading's graphical input is also reflected in both the Data navigator tree and the tables. 
We can access the load data in table 3. Loads which can be set with the button shown on the 
left. 

Again, graphic and tables are interactive: To find a load in the table, for example an imperfec-
tion, we set table 3.13 Imperfections, and then we select the load in the work window. We see 
that the pointer jumps into the corresponding row of the table (see the following figure). 

 
Figure 5.27: Interaction between graphic and load tables 
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6.  Combination of Actions 
We combine the load cases according to EN 1990. We take advantage of the generator inte-
grated in the program to superimpose the actions with the required partial safety factors and 
combination coefficients. The relevant conditions have already been created when the model 
was defined in the dialog box General Data where we have selected the option Create combi-
nations automatically (see Figure 3.1, page 8). 

The Action Type defined for the load cases (see Figure 5.22, page 62) determines the way how 
load cases are combined in different design situations.  

6.1  Checking Actions 
The load cases must be assigned to Actions which will be superimposed in accordance with 
regulations. Actions represent independent influence values that arise from different origins. 
The correlation existing between them may be neglected with regard to the reliability of the 
structural system. 

Load cases, actions and combinations are managed in the dialog box Edit Load Cases and Com-
binations (see Figure 5.22, page 62) as well as in tables number 2. We can access these tables by 
clicking the table button shown on the left. Table 2.1 Load Cases shows us the five load cases 
with the selected action categories in a clear overview. 

 
Figure 6.1: Table 2.1 Load Cases 

The subsequent table 2.2 Actions shows us the load cases that are contained in the individual 
actions. Each load case of our example is assigned to another action. However, if we had de-
fined several wind load cases for different directions, they all would be listed in the action 
Wind. 

 
Figure 6.2: Table 2.2 Actions 

The imperfections are missing in this table because they do not represent "real" actions. 
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6.2 Defining Combination Expressions 
In accordance with EN 1990, we have to combine the actions for the ultimate and the service-
ability limit state design according to certain rules. Table 2.3 Combination Expressions shows us 
which limit states are set to be analyzed. 

 
Figure 6.3: Table 2.3 Combination Expressions 

Only the ultimate limit state (ULS) is relevant for our example. Therefore, we remove the three 
check marks in the table column Use for the combination rules of the serviceability limit states 
(SLS). 

Now, we use the navigator shortcut menu to open the dialog box Edit Load Cases and Combi-
nations. We want to Edit the parameters of the combination expression CE1. 

 
Figure 6.4: Navigator shortcut menu of combination expressions 

To read describing comments informing us about the combination expression for the limit 
states STR and GEO, we use the [Info] button available in this dialog box (see figure below). 
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Figure 6.5: Dialog box Edit Load Cases and Combinations, tab Combination Expressions 

In the dialog section Settings, we activate the option Imperfection load cases to Consider the 
imperfections for the generation of combinations. When the check box is ticked, the following 
dialog box opens. 

 
Figure 6.6: Dialog box Settings for imperfection load cases 

We tick the check box in the table column Use so that LC4 can be taken into account. 
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Then, we activate the function Subject to specific load cases in the dialog section Options. 
Two more table columns will be enabled where we click into the field Only with Load Cases.  
A button [...] appears at the field end which we can use to access the dialog box Select Load 
Cases. We select LC4 Wind in +Y. In this way, RFEM will consider imperfections only in combi-
nations which include wind load cases. 

We confirm the dialog boxes shown in Figure 6.6 with [OK]. 

In the dialog section Settings of the initial dialog box, we Reduce number of generated combina-
tions by taking into account only Leading variable actions. When we tick the option, another 
tab is enabled in the dialog box. 

 
Figure 6.7: Defining leading actions in dialog tab Reduce - Leading Actions 

In the tab Reduce - Leading Actions, we clear the check box for action A3 because we want to 
superimpose the Snow load case as secondary variable load only. Thus, the number of gener-
ated combinations will be reduced. 

Before we close the dialog box Edit Load Cases and Combinations with [OK], we make sure that 
the option Generate additionally Either/Or result combination in the General tab is checked 
as well. This result combination provides the extreme values from the results of all load combi-
nations (envelope). 

RFEM creates the action combinations. When we click table tab 2.4 Action Combinations and 
return to table 2.3, the column Generated Action Combinations informs us that 13 combinations 
were created. 

 
Figure 6.8: Table 2.3 Combination Expressions, table column Generated Action Combinations 
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6.3 Creating Action Combinations 
RFEM creates automatically 13 action combinations (see Figure 6.8) which are listed and sorted 
by actions in table 2.4 Action Combinations. 

 
Figure 6.9: Table 2.4 Action Combinations 

This overview corresponds to the presentation of actions described in the standards. By select-
ing the check box in the Use column we can define the action combinations which will be con-
sidered for the generation of load combinations. Because we have applied action Qs (snow) to 
be an accompanying variable action only, we can now see that corresponding action combina-
tions where action Qs is the leading one are disabled. 

6.4 Creating Load Combinations 
15 load combinations are automatically created from the nine relevant action combinations 
(see Figure 6.9). The result is listed in the subsequent table 2.5 Load Combinations. 

 
Figure 6.10: Table 2.5 Load Combinations 

Table columns D to M inform us about load cases including respective partial safety and com-
bination factors. 

Imperfections are contained, according to our specifications, only in combinations with wind 
actions Qw. 
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Shortcut menu Load Combinations 

We use the navigator shortcut menu shown on the left to open the dialog box Edit Load Cases 
and Combinations where we want to look at the created load combinations. 

 
Figure 6.11: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

When we select the Existing Load Combinations one after the other in the list, we can see all 
load cases together with the respective partial safety and combination factors displayed in the 
dialog section to the right. Load cases which act as Leading within the combination are identi-
fied by a check mark. 

To access the partial safety and combination factors, we use the [Details] button. 

 
Figure 6.12: Dialog box Coefficients, tab Partial Safety Coefficients 
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Furthermore, we can use the Calculation Parameters tab to check the specifications applied by 
RFEM for the calculation of different load combinations. 

 
Figure 6.13: Checking the Calculation Parameters of a load combination 

Basically, load combinations are analyzed non-linearly according to the Method of Analysis for 
Second-order analysis. 
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6.5 Checking Result Combinations 
When we defined the combination expressions, we activated the option Generate additionally 
Either/Or result combination (see Figure 6.5, page 68) giving us information about the extreme 
values of all load combinations. 

RFEM generates a results envelope from the load combinations. The definition criterion can be 
checked in the final tab of the dialog box Edit Load Cases and Combinations as well as in table 
2.6 Result Combinations. 

 
Figure 6.14: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

All load combinations are superimposed with factor 1.00 and the criterion Permanent. They all 
are assigned to group 1, which means that they act alternatively. 

Now, the superposition criteria is completely defined. We can save the input with the [Save] 
button.   
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7.  Calculation 
 

7.1 Checking Input Data 
Before we calculate the model, we want RFEM to check our input. To open the corresponding 
dialog box, 

we select Plausibility Check on the Tools menu. 

The dialog box Plausibility Check opens where we define the following settings. 

 
Figure 7.1: Dialog box Plausibility Check 

If no error is detected after clicking [OK], a corresponding message is displayed, including 
summary of model and load data. 

 
Figure 7.2: Result of plausibility check 

We find more tools for checking the input by selecting 

Model Check on the Tools menu. 
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7.2 Generating FE Mesh 

Generate the FE mesh 
As we have selected the option Generate FE mesh in the dialog box Plausibility Check (see Fig-
ure 7.1), we have automatically generated a mesh with the standard mesh size of 50 cm. (We 
can modify the preset mesh size by selecting FE Mesh Settings on the Calculate menu.) 

 
Figure 7.3: Model with generated FE mesh 

Create a FE mesh refinement 
We define refinement areas for both ends of the downstand beam to generate a finer FE mesh. 

We double-click node 3 to open the dialog box Edit Node. We change to the tab FE Mesh where 
we select the check box of the option Available (see Figure 7.4). 

Since we have not yet defined any type of FE mesh refinement, the dialog box New FE-Mesh  
Refinement opens automatically. 

It is not necessary to modify the default settings Node - circular as well as the proposed Param-
eters. The FE mesh will be deleted after confirming both dialog boxes with [OK]. 

A refinement area represented as spherical form is displayed on the selected node. 
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Figure 7.4: Dialog boxes Edit Node and New FE-Mesh Refinement 

Now, we have to transfer the FE mesh refinement to the second end node of the downstand 
beam. In the Data navigator, we double-click entry 1 listed below the FE Mesh Refinements to 
access the dialog box Edit FE-Mesh Refinement. 

We click the [Select] button in the dialog section Node No. to select the second node of the rib 
graphically in the work window. 

 
Figure 7.5: Defining the second node graphically by using the [Select] function 

We close all dialog boxes with [OK]. 
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We create the mesh once again by 

selecting Generate FE Mesh in the Calculate menu. 

Then, we check the refinement areas. 

 
Figure 7.6: FE mesh with refinement areas 

7.3 Calculating Model 
To start the calculation, 

we select Calculate All on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.7: Calculation process 
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8.  Results 
 

8.1 Graphical Results 
As soon as the calculation is complete, RFEM shows the deformations of the active load case. 

 
Figure 8.1: Graphical representation of deformations for result combination RC1 

Selecting load cases and load combinations 
We can use the toolbar buttons [] and [] (to the right of the load case list) to change among 
the results of load cases, load combinations and result combinations. We already know those 
buttons from checking the load cases. It is also possible to select a specific load case or combi-
nation in the list. 

 
Figure 8.2: Load case list in the toolbar 

 

 



8  Results 

 79 RFEM Tutorial © 2013 Dlubal Software GmbH 

 
Dlubal 

 

Selecting results in the navigator 
A new navigator has appeared, managing all result types for the graphical display. We can ac-
cess the Results navigator when the results display is active. We can switch the results display 
on and off in the Display navigator, but we can also use the toolbar button [Show Results] 
shown on the left. 

 
Figure 8.3: Results navigator 

We can see check boxes placed in front of each result category (for example Global Deforma-
tions, Members, Surfaces, Support Reactions). When we select a box, we see the corresponding 
deformation or internal force displayed in RFEM. In front of the entries listed in the categories 
we see even more check boxes by which we can set the type of results to be displayed. 

Finally, we can browse the single load cases and load combinations. The variety of result cate-
gories allows us to display deformations, internal forces of members and surfaces as well as 
stresses or support forces. 

The figure below shows the member internal forces Mz and the surface internal forces my cal-
culated for CO13. To display the forces, it is recommended to use the wire-frame model. We 
can set this display option with the button shown on the left. 
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Figure 8.4: Representation of internal forces of members and surfaces (CO13) 

Display of values 
The color scale in the control panel informs us about the assignment of color ranges. Moreo-
ver, we can switch on the result values for particular locations by ticking the option Values on 
Surfaces in the Results navigator. To display all values of the FE mesh nodes or grid points, we 
deactivate the option Extreme Values additionally. 

  
Figure 8.5: Grid point moments mx of floor slab in Z view (CO13) 
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8.2 Results Tables 
We can evaluate results also in the tables. 

Table display 
The results tables are displayed automatically as soon as the structure is calculated. Like for the 
numerical input we see various tables with results. Table 4.0 Summary offers us a summary of 
the calculation process, sorted by load cases and combinations. 

 
Figure 8.6: Table 4.0 Summary 

To select other tables, we click their table tabs. To find specific results in the table, for example 
the internal forces of the floor slab, we set table 4.14 Surfaces - Basic Internal Forces. Now, we 
select the surface in the graphic (setting the Solid Transparent Display Model makes our selec-
tion easier), and we see that RFEM jumps to the surface's basic internal forces in the table. The 
current grid point, that means the position of the pointer in the table row, is indicated by a 
marking arrow in the graphic. 

 
Figure 8.7: Surface internal forces in table 4.14 and marker of current grid point in the model 

Like the browsing function in the main toolbar we can use the buttons [] and [] to select the 
load cases in the table. We can also use the list in the table toolbar to set a particular load case. 
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Adjust the results grid 
The surface results shown in the tables are listed in the grid points that are defined for the sur-
face. The results grid, like the FE mesh, has a default mesh width of 50 cm. 

To refine the grid for the result values of surface 1, we double-click the floor slab in the work 
window (or the relevant entry in the Data navigator). Then, in the dialog box Edit Surface, we 
change settings in the Grid tab: We select 25 cm for both b and h as new distance of the grid 
points. 

 
Figure 8.8: Changing the grid for result values 

When we click [OK], RFEM updates the result values in the table. A recalculation is not required 
because the grid point results are determined from the values available in the FE nodes. 

 
Figure 8.9: Result values of surface 1 with refined grid 
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8.3 Filtering Results 
RFEM offers us different ways and tools by which we can represent and evaluate results in 
clearly-structured overviews. We can use these tools also for our example. 

8.3.1 Visibilities  
We have already worked with visibilities when we entered the steel frame (see chapter 4.5.1, 
page 31). Those visibility functions are also useful when evaluating the results. 

Show results for concrete columns 
We set the Views tab in the navigator. We select Members by Cross-Section listed under the visi-
bilities that RFEM has Generated from the entered data. In addition, we select the check box for 
Circle 300 and activate the option User-defined / generated on top of the navigator. 

 

Figure 8.10: Moments Mz of concrete columns in scaled representation 

The display shows the concrete columns including results. The remaining model is displayed 
only in gray and without results. 

Adjusting the scaling factor 
In order to check the diagram of internal forces on the rendered model without difficulty, we 
scale the data display in the control tab of the panel. We change the factor for Member diagrams 
to 2 (see figure above). 
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Show results for floor slab 
In the same way, we can filter also surface results in the Views navigator. We clear the check 
box for Members by Cross-Section and select Surfaces by Geometry where we select the check 
box of the entry Plane. 

Now, when we change the result type with the button [Deformation] available in the toolbar, 
we see the following RFEM display. 

 
Figure 8.11: Deformations of floor 

As already described, we can change the display of result types (deformations, internal forces, 
stresses etc.) in the Results navigator (see Figure 8.3, page 79). 

 



8  Results 

 85 RFEM Tutorial © 2013 Dlubal Software GmbH 

 
Dlubal 

Show deformations of steel construction 
Now, in the Views navigator, we clear the check box of Surfaces by Geometry, and then we  
select Members by Material where we select the check box for Steel S 235. 

 
Figure 8.12: Filtering steel members in Views navigator 

The graphic shows us the steel construction's deformations displayed as lines. 

It is also possible to display the deformations of cross-sections: We switch to the Display navi-
gator where we 

select Results, Deformation, Members and Cross-sections Colored. 

 
Figure 8.13: Deformations of steel cross-sections 

With the panel button [Options] we can additionally activate the option Smooth color transition. 

RFEM does not display any deformations of the L cross-section, for example in CO13. We have 
defined this member to be a tension member. However, the deformation shows us that com-
pression forces are occurring. They result in failure of the diagonals, which means that this 
member is not effective within the system. 
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8.3.2 Results on Objects 
Another possibility to filter results is using the filter tab of the control panel where we can 
specify numbers of particular members or surfaces to display their results exclusively. In con-
trast to the visibility function, the model will be displayed completely in the graphic. 

First, we deactivate the option User-defined / generated in the Views navigator. 

 
Figure 8.14: Resetting the overall view in the Views navigator 

Then, in the Results navigator, we select the axial forces N of members. We can deactivate the 
results of Surfaces. 

 
Figure 8.15: Display settings for member axial forces N 
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Special selection 
To display only the axial forces of columns, we select all members in vertical position. RFEM  
offers special selection options available in a dialog box. To open the dialog box, 

we select Select on the Edit menu, and then we click Special, 

or we use the toolbar button shown on the left. 

We select the category Members and the option Parallel to member. 

 
Figure 8.16: Selecting parallel members 

Then, we use the [Select] function to click one of the column members in the work window.  
After closing the dialog boxes with [OK], all members in vertical position are highlighted.  
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Show axial forces of columns 

In the panel, we change to the filter tab where we activate the setting Members. 

We click the button [Import from Selection] and see that the numbers of all column members 
have been entered into the input field above. The axial forces of the rib as well as of the hori-
zontal beams and purlin members disappear in the graphic. 

 
Figure 8.17: Axial forces of members 

8.3.3 Range of Values 
With the color scale tab of the panel we can filter results by result values. 

First, in the Results navigator, we remove the check mark of the member results. Then, we set 
the basic internal forces nx of surfaces for display. In this case, the forces are axial forces acting 
in direction of the local surface axis x. The axis x of the curved wall surface points downwards. 

 
Figure 8.18: Setting basic internal forces nx for display 
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Looking at the wall surface, we can see high compressive forces occurring near the upper arc 
end nodes. In CO13 for example, they are introduced by both steel columns and across the rib. 
The high values are indicating singularity effects. 

To cut these result peaks for the evaluation, we switch into the color scale tab of the panel. We 
double-click the color spectrum (not the values!) and open the dialog box Edit Isoband Value 
and Color Spectra. 

 
Figure 8.19: Changing extreme value for display and [Fill]ing the value spectrum 

We reduce the extreme value of the compression forces as shown in the figure above, for ex-
ample for CO13 (-1200 kN/m instead of -5705.30 kN/m). Finally, we subdivide the value spec-
trum into equal ranges between top and bottom limit value by clicking the button [Fill]. 

After clicking [OK] the force distribution is more differentiated. Now, the zone where lifting 
forces are occurring is clearly visible. Locations of singularities not covered by the color scale 
are represented without color. 

 
Figure 8.20: Distribution of wall axial forces with adjusted value spectrum (adapted peaks, compression and tension zone) 
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Shortcut menu Member 

8.4 Display of Result Diagrams 
We can evaluate results also in a diagram available for lines, members, line supports and sec-
tions (see chapter 8.5). Now, we use this function to look at the result diagram of the down-
stand beam. 

We right-click member 3 (when we have problems we can switch off the surface results) and 
select the option Result Diagrams. 

A new window opens displaying the result diagrams of the rib member. 

 
Figure 8.21: Display of result diagrams of downstand beam 

In the navigator, we select the check boxes for the global deformations u and the internal forces 
My and V-L. The last option represents the longitudinal shear force between surface and mem-
ber. These forces are displayed when the button [Results with Ribs Component] is set active in 
the toolbar. When we click the button to turn it on and off, we can clearly see the difference 
between pure member internal forces and rib internal forces with integration components 
from the surfaces. 

To adjust the size of the displayed result diagrams, we use the buttons [+] and [-]. 

The buttons [] and [] for load case selection are also available in the result diagram window. 
But we can also use the list to set the results of a load case. 

We quit the function Result Diagrams by closing the window. 
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Selecting midpoint of line 1 
 

8.5 Creating Section 
The evaluation is made easier by user-defined sections defined as planes slicing through the 
model. The navigator manages all sections as independent objects. 

To create a new section, 

we select Section on the Insert menu 

or we use the section shortcut menu in the Data navigator. 

 
Figure 8.22: Shortcut menu Sections in Data navigator 

The dialog box New Section opens where we enter the Section Name Center because we want 
to define the section along the plate center. 

Then, we define the edge points of the section graphically by using the [Select] function: We 
click the midpoint of line 1 (global coordinates 0.000/3.000/0.000), and then we select arc node 5. 

 
Figure 8.23: Defining the section 

We accept the remaining presettings and confirm the dialog box with [OK]. 
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The familiar Result Diagram window appears. In the navigator, we select the check boxes for 
the global deformations u and the basic internal forces mx and nx. The results of the surfaces S1 
and S2 caught by the section are displayed continuously on a line. 

 
Figure 8.24: Section display in Result Diagram window 

We [Close] the Result Diagram window. Now, we see the section as well displayed in the RFEM 
work window where we set the basic internal forces mx. 

We switch off the surface results to display only the diagrams of the section (see Figure 8.26). 

With the filled display option for sections available in the Display navigator we can highlight 
the moment diagram in the model. 

 
Figure 8.25: Display options for sections in Display navigator 
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Figure 8.26: Showing the section in the model 



9  Documentation 

 

 
Dlubal 

94 RFEM Tutorial © 2013 Dlubal Software GmbH 

9. Documentation 
 

9.1 Creating Printout Report 
It is not recommended to sent the complex results output of an FE calculation directly to the 
printer. Therefore, RFEM generates a print preview first, which is called "printout report" con-
taining input and results data. We use thid report to determine the data that we want to in-
clude in the printout. Moreover, we can add graphics, descriptions or scans. 

To open the printout report, 

we select Open Printout Report on the File menu 

or we use the button shown on the left. A dialog box appears where we can specify a Template 
as sample for the new printout report. 

 
Figure 9.1: Dialog box New Printout Report 

We accept template 1 - Input data and reduced results and generate the print preview with [OK]. 

 
Figure 9.2: Print preview in printout report 
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9.2 Adjusting the Printout Report 
The printout report has a navigator, too, listing the selected chapters. By clicking a navigator 
entry we can see its contents displayed in the window to the right. 

The preset contents can be specified in detail. To adjust the output of internal forces, we right-
click chapter Results - Result Combinations. Then we click Selection in the shortcut menu. 

 
Figure 9.3: Shortcut menu Members - Internal Forces  

A dialog box appears, offering detailed selection options for RC results of members (see figure 
below). 
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Figure 9.4: Reducing output of internal forces by means of Printout Report Selection 

We place the pointer in table cell 4.6 Members - Internal Forces (see figure above). The button 
[...] becomes active which opens the dialog box Details - Internal Forces by Member. Now, we 
reduce the output to the Extreme values of the member internal forces N, Vz, My and Mz. 

After confirming the dialog boxes, RFEM adjusts the output of internal forces accordingly. 

 
Figure 9.5: Extreme values of member internal forces N, Vz, My and Mz in printout report 

 



9  Documentation 

 97 RFEM Tutorial © 2013 Dlubal Software GmbH 

 
Dlubal 

In the same way, we can adjust all remaining chapters for the printout. 

To change the position of a chapter within the printout report, we move it to the new position 
by using the drag-and-drop function. When we want to delete a chapter, we use the shortcut 
menu (see Figure 9.3) or the [Del] key on the keyboard. 

9.3 Inserting Graphics in Printout Report 
Generally, graphics illustrating the documentation are included in the printout. 

Printing deformation graphics 
We close the printout report with the [X] button. The program asks us Do you want to save the 
printout report? We confirm this query and return to the work window of RFEM. 

In the work window, we set the Deformations of RC1 - Ultimate limit state. Furthermore, we 
deactivate the Sections in the Results navigator. 

RFEM provides two results for each result combination, the maximum and minimum extreme 
values. Both values are displayed at the same time in the graphic. For our printed graphic we 
reset the display to show only the Max-values. 

 
Figure 9.6: Showing the maximum deformation results of RC1  

Now, we transfer this graphical representation to the printout report. 

We select Print Graphic on the File menu 

or we use the toolbar button shown on the left. 

The dialog box Graphic Printout appears (see figure below). 
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Figure 9.7: Dialog box Graphic Printout 

We set the print parameters as shown in Figure 9.7. We do not need to modify the default set-
tings of the dialog tabs Options and Color Spectrum. 

We click [OK] to print the deformation graphic into the printout report. The graphic appears at 
the end of chapter Results - Load Cases, Load Combinations. 

 
Figure 9.8: Deformation graphic in printout report 
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Printing result diagrams 
Finally, we want to document the distribution of internal forces available in a steel purlin.  
We close the printout report again by using the button [X]. 

Back in the RFEM work window, we right-click member 11 (purlin on high eaves). The mem-
ber's shortcut menu opens (see page 90) where we select the option Result Diagrams to access 
the result diagram. 

 
Figure 9.9: Shear force and moment diagram of purlin 

The window shows the result diagrams of RC1. For our printout we select only the check boxes 
of the internal forces Vz and My. The result diagram shows us the Max and Min Values. 

With the [Print] button we open the dialog box Graphic Printout. We can keep the default set-
tings of the tab General. In the Options tab, we change some settings. 

 
Figure 9.10: Dialog box Graphic Printout, tab Options 

We transfer the graphic to the printout report with [OK]. 
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Figure 9.11: Diagrams of internal forces for purlin in printout report 

Changing the language in the printout report 
The language in the printout report can be selected independently of the language that is set 
for the RFEM user interface. Thus, we are able to create for example a German printout report 
in the English version. To activate the function, 

we select Language on the Settings menu of the printout report. 

 
Figure 9.12: Switching languages in printout report 

In the dialog box Languages, we set German (or another language) as the new language. We 
can check the corresponding modifications in the print preview when we click [OK]. 

User-defined entries such as load case descriptions or comments won't be translated. 
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Printing the printout report 
When the printout report is completely prepared, we can send it to the printer by using the 
[Print] button. 

The PDF print device integrated in RFEM makes it possible to put out report data as a PDF file.  
To activate this function, 

we select Export to PDF on the File menu. 

In the Windows dialog box Save As, we enter file name and storage location. 

By clicking the [Save] button we create a PDF file with bookmarks facilitating the navigation in 
the digital document. 

 
Figure 9.13: German printout report as PDF file with bookmarks 
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10.  Outlook 
Now, we have reached the end of our example. We hope that this tutorial helps you to get 
started with RFEM and makes you curious to discover more of the program functions. You find 
the detail program description in the RFEM manual available as download on our website at 
www.dlubal.com/downloading-manuals.aspx. 

With the Help menu or the [F1] key it is possible to open the program's online help system 
where you can search for particular terms like in the manual. The help system is based on the 
RFEM manual. 

Finally, if you have any questions, you are welcome to use our free fax and e-mail hotline or to 
have a look at the FAQ page at www.dlubal.com. 

Note: This example can be carried out with the demo versions of the add-on modules, for ex-
ample for steel and reinforced concrete design (RF-STEEL Members, RF-CONCRETE Surfaces/ 
Members, RF-STABILITY etc.). To comply with the programs' demo restrictions, we suggest to 
replace objects: For example in RF-STEEL EC3, you can replace the beam by a cross-section  
IPE 300. In this way, you will be able to perform the design, getting an insight into the func-
tionality of the add-on modules. Then, you can evaluate the design results in the RFEM work 
window. 
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